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Crystal Structure Design AS
License Agreement

This  is  a  legal  agreement  between  you,  the  original
customer  or  any  subsequent  transferee,  and  Crystal
Structure  Design  AS  ("CSD").  By  using
CrystalDesigner  (the  "Software")  indicates  that  you
accept these terms set forth here.
1. CSD  grants  you  the  right  to  install  and  use  the

Software on only one computer at any time. If you
have multiple licenses for the Software, then at any
time you may install  and use  the  Software  on as
many computers as you have licenses for. You are
not  allowed to  install  the  Software  on  a  network
server. Please contact CSD for special arrangements
regarding  installation  on  a  network  server
(mailto:sales@crystaldesigner.no).  

2. By termination of the license you agree to destroy
or  erase  the  Software.  In  the  event  of  the
termination, the following sections of this License
will survive: 2, 3, and 4. This license sets forth the
entire agreement between you and CSD. 
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3. CSD makes no representations about the suitability
of the Software for  any purpose.  The Software is
provided  'as  is'  without  express  or  implied
warranties, including warranties of merchantability
and  fitness  for  a  particular  purpose  or
noninfringement.  This  Software  is  provided
gratuitously  and,  accordingly,  CSD  shall  not  be
liable under any theory or any damages suffered by
you or any user of the software. 

4. Title,  ownership  rights,  and  intellectual  property
rights in and to the Software shall remain in CSD.
This agreement shall be governed by and construed
in  accordance  with  Norwegian  law,  and  as  to
matters affecting copyrights and trademarks, by the
Norwegian law. You agree that any legal action or
proceedings in connection with this agreement shall
be brought in the Norwegian courts and irrevocably
subject  to  the  exclusive  jurisdiction  of  Oslo  City
Court. You acknowledge that the Software in source
code  form  remains  a  confidential  trade  secret  of
CSD  and  therefore  you  agree  not  to  modify  the
Software  or  attempt  to  decipher,  decompile,
disassemble or reverse engineer the Software.
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1. Welcome

About CrystalDesigner
CrystalDesigner is a computer program available on the Macintosh platform. The program is a
complete tool for building, studying and visualising all kinds of inorganic crystal structures.
CrystalDesigner is intended to be used by students and teachers at colleges and universities and
by scientists at universities and in the industry. 

From an educational point of view, CrystalDesigner will make the learning of crystallography
more interesting and will provide a faster way of understanding crystal structures in general.
This is possible through the easy-to-use graphical user interface to CrystalDesigner. 

From a scientist point of view, CrystalDesigner is a lighting fast way of creating all kinds of
graphical representations of inorganic crystal structures. 

Main features of CrystalDesigner:
All  kind of  crystal  structures can be build by knowing the crystal  system, space group,
lattice parameters and atom positions. The program generates symmetry elements and atom
positions based on the input.
Viewing the crystal structure can be done in three different ways: i) as unit cells or multiples
of it, ii) as a plane with a user defined thickness or iii) by coordination around a selected
atom within a user defined ratio. 
The atoms may alternatively by viewed as points, circles or spheres. Bonds between atoms
can be created and be viewed as lines, cylinders or cones. Groups of atoms can alternatively
be viewed as polyhedra. 
The crystal structure may be rotated in any direction or around a fixed axis. Distance and
angle between atoms can be measured.
CrystalDesigner  is  a  multiple  document  window  application.  Each  document  window
contains all the necessary the information about a crystal structure and for each document
the program can create multiple windows visualising the crystal structure.

Different versions
Three different versions of CrystalDesigner have been made in order to take advantage of the
different  processor  configurations:  They  are  named  CrystalDesigner  DR4,  68k-version,
CrystalDesigner DR4, FPU-version and CrystalDesigner DR4, PCC-version. There is also a
fourth  version  named  CrystalDesigner  DR4  68k  +  PPC-version  that  consist  of  both
CrystalDesigner DR4 68k-version and the CrystalDesigner DR4 PCC-version. You do not need
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to worry about which version to use. The CrystalDesigner installer program on Disk #1 does
the job for you. 

Installation  8



Welcome  9

CrystalDesigner  DR4 68k-version runs on all  Macintosh computers  with a  68020 CPU or
higher.  CrystalDesigner  DR4 FPU-version  require  a  Macintosh  with  a  68020,  68030 or  a
68040 CPU with a math coprocessor installed to run, and CrystalDesigner DR4 PPC-version
require a Power Macintosh to run. 

What You Need
CrystalDesigner runs on all Macintosh computers with a 68020 CPU or higher. This includes
all Macintosh models except Macintosh 128, 512, Plus, SE, Portable, Classic and PowerBook
100. 

In addition, CrystalDesigner requires that you have a hard drive, System 7 or higher and at
least 2.5 MB of available memory to run. When you install CrystalDesigner on your startup
disk, it takes up about 4-5 MB of your disk space.

About this documentation
This user's guide contain the necessary information to use CrystalDesigner. The guide consist
of four parts: Welcome, Installation, Tutorial and finally a part that describes the Menus and
floating Windows.

Welcome

This is the part you are reading now. It gives you a general introduction about CrystalDesigner
and the necessary requirements to be able to use the program. You will also get information
about how to get support and how to get the latest news about CrystalDesigner.

Installation

The installation part tells you how to install CrystalDesigner. Be sure to read the installation
instructions before you install CrystalDesigner. 

Tutorial

The tutorial part gives you an introduction to the basics of CrystalDesigner. You will learn how
to build a crystal structure and how to create different graph views of a crystal structure. It will
take you about half an hour to complete the tutorial. If you do not normally read manuals,
please at least scan through the tutorial. 
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Menus and floating windows

Here all the CrystalDesigner menu commands will be described. A description of the floating
windows visible when a graph window is active is also present.
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Naming Conventions
Names of menus, buttons, commands and icons are in boldface.

A crystal structure project is defined as the document window containing the crystal structure
data and all  the graph windows representing the crystal structure.  Figure 1.1 shows you a
graphical illustration of the definition of a crystal structure project.
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Graph Windows

Document Window

Figure 1.1 A crystal  structure  project  is  defined as  the  document  window containing  the
crystal structure plus all the graph view belonging to the corresponding crystal
structure.
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Support and info
All  customers  of  CrystalDesigner  will  receive  free  support  through  Internet  by  sending
mailto:support@crystaldesigner.no.  We  will  reply  to  all  questions  about  CrystalDesigner
within 24 hours.  Please,  send also general  feedback about CrystalDesigner.  We will  try to
incorporate  as  many  as  possible  of  the  suggested  features  in  upcoming  versions  of
CrystalDesigner.

Information about CrystalDesigner is also available via WWW on the Internet. Here you can
find  the  latest  news,  example  files,  order  and  contact  information,  feature  list,  company
information and demo versions of the CrystalDesigner. The address is:

http://www.oslonett.no/CrystalD/index.html.

You can also download demo versions by using ftp. The address is
ftp://ftp.oslonett.no/Software/Mac/omp/crystald/

Release Schedule
Crystal  Structure Design AS plans to release new versions of  CrystalDesigner with a four
month interval.  The next two releases will be CrystalDesigner DR5 scheduled for Mars 1996
and CrystalDesigner DR6 scheduled for August 1996. 

Please note that all current customers will receive free updates of both CrystalDesigner DR5
and DR6. The updates will be sent to you free of charge by Air mail when they are available. 

Our goals for the next two releases: 

- Import of crystal structure data from text files. (CIF format , ++++ ) 
- Support for coordination polyhedra around atoms that have coordination twelve or less
- Support for occupancy lower than 100 %
- Improved documentation 
- Full support of QuickDraw 3D

References to text books
This manual assumes you are familiar with or are in the process of learning Crystallography,
the  science  concerned  with  the  study  of  crystal  structures.  Supplementary  readings  are
available. Check out

"International Tables for Crystallography", Volume A, Edited by Theo Hahn, Kluwer Academic

Installation  13



Welcome  14
Publishers, Dordrecht, 1992, ISBN 0-7923-1678-9

"Fundamentals of Crystallography", Edited by C. Giacovazzo, Oxford University Press, 
Oxford, 1992, ISBN 0-19-855579-2

"Solid State Chemistry and its Applications", Written by A. R. West, John Wiley & Sons, New 
York, 1987, ISBN 0-471-90377-9
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Figure 1.2 A screen capture of the Home Page of CrystalDesigner on Internet
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2. Installation

Before you install CrystalDesigner DR4, be certain that you have enough space on your startup
disk. The installation will require about 4-5 MB of disk space. If you have a math processor
emulator  (SoftwareFPU)  installed  on  your  computer,  turn  it  off  before  you  install
CrystalDesigner DR4.

To install CrystalDesigner, insert Disk #1 and double-click the file CrystalDesigner Installer.
You will see a dialog like the one in figure 2.1. 

Figure 2.1 Welcome to the Installer for CrystalDesigner

Click continue and a dialog like the one in figure 2.2 appears on the screen. 

Figure 2.2 Installer note dialog. 
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If you accept the Crystal Structure Design AS License Agreement, Click Continue to complete
the installation. The Installer now installs the program, example files and documentation into a
folder named CrystalDesigner DR4 on your startup disk. When the installation is completed
the following dialog box appears.

Figure 2.3 A dialog that confirms that installation was successful.
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3. Tutorial: CaTiO3
This  tutorial  will  give  you  an  introduction  to  CrystalDesigner.  As  an
example through the tutorial, the cubic perovskite CaTiO3 will be used
(high temperature phase). You will be guided through four sections. The
first section describes how to enter the crystal structure data, while the
last  three sections describe how to create different  graph views of the
crystal structure entered. 
The first graph view section you will learn how to create a unit cell from
the crystal structure data entered. You will also learn how to insert bonds
and how to define polyhedra around atoms. In addition a description on
how to measure distances and angles between atoms is also present. 
In  the second graph view section you will  learn to  create  a  graphical
representation of  a  plane  through the  crystal  structure.  It  will  also  be
shown how to add thickness to the plane and how to shift distance from
origin. At the end of this tutorial you will learn how to make a graph view
of the coordination around a atom.

Entering the Crystal Structure Data

Document window
When  you  start  CrystalDesigner  a  new  untitled  window  appears  on
screen, shown in figure 3.1.
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Figure 3.1 A new untitled document window. No data has yet been
entered.
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This  window is  called  the  document  window.  The  document  window
contains the data of the crystal structure. The window consists of five
regions; the crystal system, the space group, the lattice parameters, the
atom positions and the reference region. From the data entered in these
regions you can create as many graph windows as you like representing
different views of the crystal structure. Let us start by entering the crystal
structure data of CaTiO3 into the document window.

Crystal system

The first thing you need to do is to select the crystal system from the popup menu in the document window. Choose the Cubic crystal
system as shown in figure 3.2.

Lattice parameters

After choosing the cubic crystal system, enter CaTiO3 crystal structure lattice parameter into the edit box in the lattice parameter
region, a = b = c = 380 pm. Enter the lattice parameter. Only numbers and the decimal separator character are accepted. Please note
that CrystalDesigner uses the decimal separator character defined by your system software. End the input with pressing the tab key. 

Space group

Cubic perovskite has space group symmetry Pm-3m (221). Choose this entry from the Space Group popup menu.

      

Figure 3.2 This figure shows a popup menu for choosing a crystal system. The second menu is the Edit menu. Here, the user
is adding an atom position to the atom position table. 

Atom positions

Cubic perovskite (CaTiO3) contains three atom positions. Only one atom position is currently defined. Add therefore two new atom
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positions by choosing Add Atom Position two times from the Edit menu, as shown in figure 3.2.

Select the first cell in the element column in the atom position table. The first atom position to enter is calcium. You can either type
in the symbol, the element number or choose the element from the arrow 
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popup menu located on the right side of the input field. Figure 3.3 shows the document window at this stage when the popup menu
are pulled down. 

Figure 3.3. The document window with the element popup menu pulled down. 

Calcium is located in the origin of the unit cell, (0 0 0). Enter the coordinates. You can navigate between the different cells by using
the tab or arrows keys or you can just click in the cell that you want to change or enter a new value.
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Figure 3.4. Radius lookup table dialog window.

To complete the entering of the atom position of calcium, you also need to enter the radius of the element. You can enter the radius
directly or you can let CrystalDesigner suggest a radius by opening the lookup table by clicking Look Up button on the left side of
the input field. Figure 3.4 shows the Radius Lookup Table Dialog.

CaTiO3 is an ionic crystal structure and the calcium atoms have oxidation state two and they are twelve coordinated. You can select
the correct radius by clicking on the specific row. To return to the document window, click OK. Press tab key to confirm the radius
you just selected.

Currently only occupancy equal to 100% is accepted as input in CrystalDesigner DR4. Complete the rest of the atom positions by
inserting the values given in figure 3.5. Remember to confirm the last cell you enter.

Reference

The reference field at the bottom of the document window is a place where you can store the reference to the crystal structure data.
The crystal structure data in this example has been taken from "Barth, Norsk Geologisk Tidsskrift, 8 (1925) p 201".
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Figure 3.5 The document  window when  all  crystal  structure  data  are  entered.  Please  note  that  CrystalDesigner  uses  the
decimal separator character defined by your system software.

Save data

It is time for saving the data. Choose Save Crystal Structure from the File menu (not possible in the demo version). You may name
the file Perovskite. The dialog should then look like figure 3.6 when you save the data. Click Save.

Figure 3.6 An example of a standard file dialog box.
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Creating a unit cell drawing

A unit cell drawing can be created by choosing New Unit Cell View from the Windows menu as shown in figure 3.7. The unit cell
window, also shown in figure 3.7, will then be created.

       

Figure 3.7 The Windows menu and a graph window displaying a unit cell.

In addition, two floating windows are also shown when the unit cell window is in front. These windows are shown in figure  3.8 and
they are only visible when a graph window is in front. By activating the document window containing the crystal structure data the
floating windows will disappear again. To bring the unit cell window in front again choose Perovskite, Unit Cell from the Windows
menu.

    

Figure 3.8. Floating windows. The empty window is the Info Window. The window containing the icons is the Tool Window.

Distances and angles between atoms

The  arrow icon  shown in  the  margin  is  called  the  Selection  Tool.  With  this  tool
selected you can select different atoms in the drawing.

When an atom is selected the information about the atom is shown in the info window. By shift clicking you can select up to three
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different atoms. The info window will then display additional information 
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about the distances and angles between the atoms selected. You can deselect the atoms by clicking somewhere else in the drawing. 

Rotation of the drawing

The globe icon is called the  Free Rotation Tool. With this tool selected you can
rotate the unit cell in space by mouse dragging. 

Try to rotate your unit cell. A circle in the drawing is shown when a rotation task is performed. The circle symbolise a silhouette of a
sphere. It will help you to make the rotation easier. It is also possible to rotate the drawing by using the arrow keys. 

Flickering

When you are rotating the unit cell the window flickers. To avoid the flickering, you can turn on the off screen buffering. This can be
done by choosing BitMap Buffering from the Render menu.

Graph modes

The three icons in the bottom of the tool window symbolise three different modes of the drawing. The different modes are:

Atoms Only Mode. Only atoms are drawn.

Atoms and Bonds Mode. In this mode bonds and atoms are drawn and it is possible to
create or modify coordination bonds between elements.

Atoms and Polyhedra Mode. Polyhedra and atoms are drawn and it is possible to
create new coordination polyhedra around an element.

Inserting bonds

To define coordination bonds, choose Insert/ Modify Bonds from the Coordination menu. This entry is only enabled if you are in
Atoms and Bonds Mode.  Insert  bonds between the titanium atoms and the oxygen atoms . After you have selected the atoms
involved in the bonds, click the Add button. Your dialog at this stage should look like the dialog in figure 3.9.
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Figure 3.9. The edit bonds dialog.

Click  OK. The drawing now displays the coordination bonds between oxygen atoms and titanium atoms.  Figure 3.10 shows the
graph window when the bonds have been inserted. Your graph window may have been rotated differently.

Figure 3.10 A graph window displaying a unit cell of CaTiO3 with coordination bonds defined between oxygen and titanium
atoms.

Inserting polyhedra

Select the Atoms and Polyhedra Mode icon. The bonds that we have created are now hidden. To insert a polyhedron around the
titanium atom, choose Insert Polyhedra Around and the sub entry Titanium from the Coordination menu as shown in figure 3.11. 
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Figure 3.11. The Coordination menu. The user is inserting polyhedra around titanium atoms.

As you can  see  on your screen  or  in  figure  3.12,  CrystalDesigner  automatically  calculates  the  coordination  polyhedra  around
titanium, which in this case is an octahedron. Figure 3.12 also includes a graph window where eight unit cells are displayed. Choose
(2x2x2) Units from the Size menu to view these eight unit cells. 

 

Figure 3.12. A graph window displaying a unit cell of CaTiO3 with coordination polyhedra defined between around the titanium
atoms.

Choose Save Crystal Structure from the File menu to save your current work. If you want to save your unit cell graph to a PICT
file, you can choose Save Graphics from the File menu to save the drawing to a file.

Viewing a plane in the crystal structure

In this section you will learn how to create a graphical representation of a plane through the crystal structure. It will also be shown
how to add thickness to the plane and how to shift distance from origin.

Installation  29



Welcome  30

Defining a plane

To create a new plane view, choose New Plane View from the Windows menu as shown in figure 3.13.

 

Figure 3.13. The window menu. The user is creating a new plane view. 

A dialog box appears on the screen. In this dialog box you can select the hkl plane you want to view. In this tutorial, select the (111)
plane. This can be done by entering the numbers or by choosing the plane from popup menu named Predefined. At this stage your
dialog should look like figure 3.14.

Figure 3.14. The plane info dialog box. The user has selected the (111) plane.

Click OK and a new graph view window appears named Perovskite, (111) plane. 

Moving the plane away from origin

The boundary of the plane displayed is defined by the first octant. In the case where one of the crystallographic axes is parallel to the
plane, you can define how many unit cells that should be included in the specific direction. In our case none of the axes are parallel
to the displayed plane.
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The current plane is at a distance d from origin. To incorporate more atoms in the drawing you can transfer the defined plane away
from origin by an integer multiply of d. This is possible by choosing a sub entry of the menu item Distance from Origin from the
Size menu. Choose 7d as shown in figure 3.15.

       

Figure 3.15 The Size and Atoms menus. In the Size menu the user transfers a plane to a distance 7d from origin. In the Atoms
menu the user selects an entry to change the relative atom radius.

To see the close-packing of this layer, change the relative size of the atoms to 100%. Choose Relative Size from the Atoms menu.
Enter the value 100 and click OK. Your graph window should now look like figure 3.16.

Figure 3.16. A graphical representation of the (111)plane at a distance of 7d from origin. The relative size of the atoms is set to
100%.
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Adding thickness to a plane

Often it is interesting to see the packing of the layers of a crystal structure. This can be done by adding a thickness to a plane. To add
thickness to the plane, choose Other Plane Size from the Size menu. A dialog as shown in figure 3.17 appears. Change the thickness
above the plane to 1000 pm and and click OK.

Figure 3.17. A plane size dialog box. A thickness of 1000 pm above the plane has been entered.

After a rotation the plane the drawing of the plane may look something like figure 3.18.

Figure 3.18. A graphical representation of the (111)plane in a distance 7d from origin. The relative size of the atoms is set to
100% and the thickness above the plane is set to 1000 pm. 

Installation  32



Welcome  33

Viewing a coordination around a atom

To view the coordination around a atom, choose  New Coordination View from the  Windows menu. Select the calcium atom as
shown in figure 3.19 and click OK. 

Figure 3.19. A dialog where the user can select an atom to view coordination around. Calcium (0,0,0) has been selected.

A new window viewing the coordination of calcium then appears. Atoms within a given radius are included in this drawing. The
given radius (R) is calculated by the equation 

R = r0 + ∂

where r0  is the distance to the nearest neighbour and ∂ is the acceptable variation in distance from the core atom between the
neighbouring atoms. The default value of ∂ is 20 pm. 

You can change the values of R and ∂. To change R directly, choose Other Radius ... from the Size menu. To Change ∂, choose
Other Variation ... from the Size menu. Try to experiment with different values. Figure 3.20 gives you an example of this view.
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Figure 3.20. A graphical  representation  of  the  coordination  around  the  calcium atom.  The  maximum variation  in  distance
between neighbouring atoms to the core atom is set to 50 pm. Bonds have been inserted between calcium an
oxygen atoms. From the Render menu Hide Reference Framework have been chosen. 
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4. Menus and Floating Windows

This chapter describes each of the CrystalDesigner menu commands. It is organised by menu, from left to right along the menu bar.
Within each menu commands are described in the order in which they appear in the menu. 

The Apple Menu

The menu entry About CrystalDesigner ... tells you what version of CrystalDesigner you are using and how to get in contact with
Crystal Structure Design AS.

The File Menu

Use the File menu commands to work with files that you open and edit. The menu also lets you save graphics and text to files. Figure
4.1 shows you the file menu.

Figure 4.1 File menu

New Crystal Structure

The  New Crystal  Structure  opens  a  new  untitled  document  window.  You  can  have  as  many  document  windows  open
simultaneously as you like. The maximum number of windows are only limited by the application memory. 
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Open Crystal Structure

The Open Crystal Structure command displays a dialog that lets you select from existing crystal structure files on disk and open
one for editing and displaying. A crystal structure file contains the data and all the graph windows created or modified last time the
user saved the crystal structure.

Close Crystal Structure

This command has the same effect as clicking in the active document window's close box. A dialog box asks if you want to save the
changes,  discard  them, or  cancel  the  Close command.  When you closes  the  crystal  structure  document  window all  the  graph
windows that belong to that crystal structure will also be closed.

Close

If a crystal structure document window is active, the Close command has the same effect as the Close Crystal Structure command.
The document window plus all its graph windows will be saved and closed. If a graph window is active, a dialog box will appear and
you you must confirm that you want to remove this graph view from your crystal structure project. The confirmation dialog is shown
in figure 4.2.

Figure 4.2 A dialog box asking you if you really want to delete the active graph window.

If you confirm the command the graph window will be closed and all the information stored will be lost. Sometimes you want to
active a window that is not visible. Instead of closing graph windows or moving windows until you can click on a part of a window
you want to activate, you can select the window from the Windows menu. All displayed windows are listed in this menu.

Save

This command saves the all the windows belonging to the active crystal structure project. A crystal structure project consist of a
document window containing the crystal structure data and all the graph views representing the particular crystal structure. When
you perform the Save command all windows are stored to file. In other words when you open your crystal structure project next time
the windows will appear in the same order, position and size and they will contain the same information as last time you saved the
crystal structure project.
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Save As ...

This command allows you to save the active crystal structure project under an other name. The active project is the same project the
the front most window on screen belongs to. If you have made edits in the current session, they are saved under the new name. The
original project remain unchanged.

Revert to Saved

This command restores the last saved version of the current active project and discard any edits made since the last save.

Save Graphics

The  Save Graphics command allows you to save the active graph view to file. The drawing will be saved as a PICT file. The
resolution of the saved drawing is dependent on wether you us  BitMap Buffering or not. You can check what kind of buffering
using by examinate the  Render menu. If  BitMap Buffering is on the resolution is the same as the screen resolution, else the
resolution is device dependent. If you want to print the file, the resolution of the drawing is the same as the resolution of the printer. 

Save Text

This command saves the text in the crystal structure data window.

Page Setup

This command displays the standard Page Setup dialog that lets you specify the size of the paper you are printing on, and whether the
file should be printed upright on the page(tall orientation) or sideways(wide orientations).

Print

This commands opens a dialog thatlets you print the contents of the active graph window. The resolution of the output of the graph
views are dependent on if you are using BitMap buffering or not. If the  BitMap Buffering in the  Render menu is checked the
resolution on the output will be the same as the screen resolution, else the resolution of the drawing will be the same as the resolution
of the printer you are using.

Quit

This command exits CrystalDesigner program. If you have any open crystal structure projects you will be asked if you want to save
the changes for each one of the projects.
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The Edit Menu

The Edit menu contains the standard Macintosh editing commands: Cut, Copy, Paste as well as the commands editing the crystal
structure data. Figure 4.3 shows the menu.

Undo

The Undo command reveres the last edit operation. The name of this command changes to reflect the operation you are undoing.
After a paste, for instance, this command changes to  Undo Paste.  Once you have undone something, the name of this command
changes to Redo. If nothing exist to undo, this command is dimmed.

Cut

This command removes selected text and places it in the Clipboard. It replaces the current contents of the Clipboard. Use the Paste
command to insert text from the Clipboard into your file at the insertion point.

Figure 4.3. Edit menu

Copy

This command copies the selected text or graph view and place it in the Clipboard. Note that if a graph window is active, the name of
this menu command changes to Copy Graph View. The copy, containing text or graphics, can now be pasted somewhere else using
the Paste command. 

Copy Info Window

This  command lets  you copy the  content  of  the Info Window. The copy can now be  pasted  somewhere  else  using the  Paste
Command.
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Paste

This  command  copies  the  contents  of  the  Clipboard  into  the  text  field  being  edit  at  the  insertion  point.  Please  note  that
CrystalDesigner currently do not letsyou paste row or columns or both into the atom position table in crystal structure data window. 

Clear

This command clears the selected text, but the cleared text is not placed in the Clipboard. 

Add Atom Position

This command lets you add a new atom position row to the atom position table. The command is only active if a document window
is active. The atom position table can contain up to 32767 positions. By the introduction CrystalDesigner DR5 you will be able to
import data from text files (CIF -format).

Delete Atom Position

This command allows you to delete the selected row in the atom position table. You can select a row by clicking in its row first cell.
The last position in the atom position table is not possible to delete. If no row is selected this command is dimmed.

Show Clipboard

This command opens a window that displays the content of the Clipboard.

The Atoms Menu

The Atoms menu contains commands for editing the atoms in a drawing. You are able to change the relative size, the colour and the
appearance of the atoms. Figure 4.4 shows the Atoms menu.
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Figure 4.4 Atoms menu
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Modify an Element

This command opens a dialog box that lets you change the colour and appearance of a specific element. The elements can be edited
by selecting the element from the Current Element popup menu, which contains all the elements in the drawing. Figure 4.5 shows
you the Modify Element dialog box.

Figure 4.5. A dialog box that allows you to change the formatting of the elements.

You can label the elements with atom symbol, atom number or atom position. If your displayed atoms are to small to incorporate the
label within the atom, the label will not be drawn. If some labels are hidden, you can make them visible by increasing the relative
size of atoms or by making the graph window larger.

Click OK when you are finished with the formatting of the elements. 

Modify a Position

This command opens a dialog box that lets you change the colour of a specific position in your active crystal structure. Figure 4.6
shows you the Modify Atom Position dialog box. 

Figure 4.6 The Modify Atom Position dialog box.
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You will typically use this dialog if one of your elements in the drawing consists of more than one atom position. You can set a
unique colour for each atom position. If you change the colour of an element in the Modify Element dialog, only the atom positions
with the same defined colour as the defined element colour will be changed.

Relative Size

This command opens a dialog box that lets you change the relative size of the atoms in the drawing. You can enter integer values
from 1 to 100. When the relative size is set to 100, the displayed radius of the atoms correspond to the radius given by the atom
positions.

No label
Atom Symbol Label
Atom Number Label
Atom Symbol Label

With these commands you are able to label the atoms in different ways. Please note that if your displayed atoms are to small to
incorporate the label, the label will not be drawn. If some labels are hidden, you can make them visible by increasing the relative size
of atoms or by making the graph window larger. Please note that these command entries override the element labelling done in the
Modify Element dialog.

Expand Coordination

This command is enabled if a single atom is selected. By choosing this command a new graph window will appear displaying the
coordination around the selected atom.

Hide Atom

This command is enabled if a single atom is selected. By choosing the Hide Atom command the atom and all the bonds connected to
the atom will be hidden. If the hidden atom is a core atom of a polyhedron, the polyhedron will not be shown in the  Atom and
Polyhedra Mode. To display the hidden objects, choose Show All from the Atoms menu.

Show All

This command makes all the hidden atoms and the bonds connected to the hidden atoms visible again.

The Coordination Menu

The Coordination menu contains commands for creating bonds and polyhedra around atoms.
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Figure 4.7 The Coordination menu. 

When your active graph window is in Atoms and Bonds Mode, the upper part of the Coordination menu is enabled, shown to the
left in figure 4.7. When your active graph window is in Atoms and Polyhedra Mode, the lower part of the menu is active, shown to
the right in figure 4.7. When the active graph window is in Atoms Only Mode all the Coordination menu commands are dimmed.
The different modes are explained in the section describling the Tool Window on page 40.

Insert/ Modify bonds

This command opens a dialog box that allows you to insert new bonds between elements or to modify already defined bonds. Figure
4.8 shows this dialog box.

Figure 4.8 A dialog box for inserting and modifying bonds between elements. Here, bonds between titanium and oxygen have
be defined.

Remove All bonds

This command removes all defined bonds in the active graph window.
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Relative Bond Size

This command opens a dialog box that lets you change the relative bond size of all the bonds in the active graph window. The
relative bond size is defined as the radius of the smallest atom in the bond times the relative size / by hundred.
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Colour of Bonds

This command lets you open a dialog to change the current bond colour.

Insert polyhedra Around

When you choose this command, you see a hierarchical menu with the elements that you can define polyhedra around. If an element
is  a  part  of  corner  of  a already defined polyhedron or  is  a  core atom of a polyhedron,  the element  will  not  be visible in  the
hierarchical menu. 

CrystalDesigner DR4 supports square, tetrahedron and octahedron. CrystalDesigner DR5 will expand the support by several new
polyhedra.  Our  goal  is  to  support  polyhedra  around  elements  that  have  coordination  twelve  or  less  by  the  introduction  of
CrystalDesigner DR5. 

Remove polyhedra around
Remove all Polyhedra

Removes polyhedra around a specific element or removes all the polyhedra in the active graph window. These commands are not
undoable.

The Render Menu

The  Render menu contains commands that lets you control how the crystal structure should be converted into an image on the
screen. You have the possibility to choose the projection method and how the atoms, bonds and polyhedra will be displayed. In
addition you can also add a reference framework and a colour background to your displayed drawing. Figure 4.9 shows you the
Render menu.

Figure 4.9 The Render menu.
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Parallel projection

In parallel projection mode equal objects are displayed with same size independent of the distance from the viewer.

Perspective projection

In perspective projection mode equal objects are displayed with different size independent of the distance to the viewer. The nearest
objects are largest.

Colour Shading

When this command is selected, atoms are drawn as spheres and bonds are drawn as cylinders. The colour of surface of the objects is
determined by the angle between surface normal and the vector from the surface to the viewer. 

Building up a drawing in this mode increases the update time by a factor 100. We recommend that you use this mode only when you
are satisfied with all the other view parameters.

Single colour Fill, Black Frame

When this command is selected, atoms are drawn as circles and bonds are drawn as planar polygons. The objects are filled with the
default or user defined colour with a black frame around. In the case where the atoms are smaller or equal to a dot on the screen, the
atoms are displayed as a point. Equally, the bonds are displayed as lines. 

White Fill, Colour Frame

When this command is selected, atoms are drawn as circles and bonds are drawn as planar polygons. The objects are filled with
white colour and as a user default or user defined colour around. 

White Fill, Black Frame

When this command is selected, atoms are drawn as circles and bonds are drawn as planar polygons. The objects are filled with
white colour and the frame around the object is drawn in black.

Show/ Hide Reference Framework

With is menu command you can toggle off and on the reference framework in your drawing. The reference framework is dependent
on which kind of graph you are displaying. When it is a unit cell view a framework showing the unit cell bonds is drawn. If you are
displaying a plane of your crystal structure the unit cell axis and the boundary of the plane is displayed. If you are displaying a
coordination around an atom the reference framework shows the crystal system axes though the centre. 

Show/ Hide Axis Label

This command is only enabled when the reference framework is drawn. By using this command you can toggle between showing or
hiding the axis labels. 
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No Buffering

When this menu entry is selected CrystalDesigner draws directly in the window. If an update event occur CrystalDesigner redraws
the hole crystal structure. This will slow down your the speed of the program. An advantage using this mode is that you see the
progress in drawing and you do not need memory available for making a off screen image. 

PICT Buffering

This option is likely to be removed in the next update.

BitMap Buffering

When this menu entry is selected CrystalDesigner makes an off screen image before the program copies the image into the graph
window. If an update event occur the stored image will be copied into the window. CrystalDesigner stores the off screen image in the
system memory. If you have problems with activating this command, you should try to close other open program in order to release
more memory to the system.

Background Colour

By choosing this command a dialog box is opened. The dialog lets you change the background colour of the active graph window.

The Size Menu

The Size menu contains commands that lets you change the size of your drawing. When a unit cell view is active the upper part of
the menu is enabled as shown to the left in figure 4.10. When a plane view is active the part in the middle of the menu is enabled and
finally when a coordination view is active the lower part of the menu is active, shown to the left in figure 4.10.

    

Figure 4.10 The Size menu
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(1 x 1 x 1) Units
(2 x 2 x 2) Units
(3 x 3 x 3) Units
(4 x 4 x 4) Units

These commands lets you control how many unit cell that should be display in each crystal system directions. For example the
command (2 x 2 x 2) Units changes the drawing to include two unit cell in each direction with the result that eight unit cell are
displayed. 

Other Unit Cell Size

This command opens a dialog box that lets you set the number of unit cells that should be display in each crystal system directions.
You can enter integer values 1 to 1000 in the input fields. The initial values displayed, is the current size of the drawing. Figure 4.11
shows you the dialog.

Figure 4.11 A dialog box for setting the number of unit cells that should be displayed in each crystal system direction.

Hide/ Show shared Neighbour Atoms

This command lets you include or exclude atoms from neighbouring unit cells that shares corner, axes or surfaces with the unit
cell(s) you are displaying. If the menu entry text is Hide shared Neighbour Atoms, the shared neighbouring atoms will be removed
from the drawing. When the menu entry text is Show shared Neighbour Atoms, the shared neighbouring atoms will be added to the
drawing. 

For instance, suppose that you have a crystal structure containing only atoms located in origin (0,0,0) of the unit cell. When you
display it as a unit cell with shared neighbouring atoms, you will see 8 atoms. By hiding the shared neighbouring atoms, only one
atom will be displayed.

Distance from Origin

When you choose this command, you see a hierarchical menu with different choices d distances from origin. The boundary of the
plane displayed is defined by the first octant. You can therefore incorporate more atoms in the drawing by transferring the defined
plane away from origin. 

Installation  48



Welcome  49

Units Along a-Axis
Units Along b-Axis
Units Along c-Axis

With these commands you can define how many unit cells that should be included in the specific direction in the case where one of
the crystallographic axes is parallel to the plane. If the plane is not parallel to a specific direction, the specific menu entry is disabled.
Please note that the boundary of the plane displayed is defined by the first octant. 

Other Plane Size

This command opens a dialog box that lets you set all the boundary conditions for the active plane view, shown in figure 4.12.

Figure 4.12 The plane size dialog.

In the upper part of the dialog you can set the boundary of the plane. Please note that in the cases where the plane is not parallel with
the crystal system axes, the boundary of the plane is defined by the first octant. The effect of this definition is that when you transfer
the plane away from origin the plane size is increasing. If the plane is parallel with any of the crystal system axes you can define how
many unit cells that should be included in the specific direction.

In the lower part of dialog you can specify the thickness of the plane.

Max Variation in Distance

When you choose this command, you see a hierarchical menu with different choices of the maximum allowed variation in distance
between the core atom and the surrounding nearest neighbours.  Atoms within a given radius will be included in drawing dependent
on which value you choose. The given radius (R) is calculated by the equation 

R = r0 + ∂
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where r0 is the distance to the nearest neighbour and ∂ is the maximum allowed variation in distance from the core atom between the
nearest neighbouring atoms. 

Include Atoms Within

When you choose this command, you see a hierarchical menu with different choices of the radius to include atoms within from the
core atom. All atoms within the radius your have choosen will be included in the drawing.

Other Variation ...

This command open a dialog box that  lets you manually change the maximum variation in distance from the core atom to the
surrounding nearest neighbours, figure 4.13. Atoms within a given radius will be included in drawing. The radius (R) is calculated by
the equation 

R = r0 + ∂

where r0  is the distance to the nearest neighbour and ∂ is the  max variation in distance from the core atom between the nearest
neighbouring atoms. 

Figure 4.13 A dialog box for  changing the maximum variation in  distance from the core atom to the surrounding nearest
neighbours

Other Radius ...

This command open a dialog box that lets you manually change the radius you want to include atoms within.

The Windows Menu

The Windows menu contains commands creating new graph views. In addition this menu displays a list containing all the currently
open windows. The list is located in the bottom of the menu. Figure 4.14 shows the menu.
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Figure 4.14 The Windows menu

Preferences

The  Preferences command opens a dialog box that ables you to change the default settings in the program. You can change the
default settings of: the graph windows, rendering options, rotation steps, element colours, element ratios, atom design, bond design,
unit cell view parameters, plane view parameters and the coordination view parameters. 

Show Info Window

If a graph view is active and the info window has been closed, this command will make the info window visible again

Show Tool Window

If a graph view is active and the tool window has been closed, this command will make the tool window visible again.

Show Crystal Structure Data

This command opens a window that displays the general positions of the chosen space group and the atom position in the unit cell
generated from the general position and the atom position list. If the window is already open this command is disabled. You can then
instead access the window by choosing its menu entry in the lower part of the Windows menu.

New Unit Cell View

This command creates a new unit cell view window based on the default settings. You can view the different default settings by
choosing the command Preferences in the Windows menu. 
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New Plane View

This command opens a dialog that lets you specify which plane you want to view, see figure 4.15. You are only allowed to enter
integer values. Inside the dialog box there is a popup menu that lets you choose the most common planes. The graph on the left side
in the dialog display the current selected plane in a distance d from origin.

The parameters for the initial plane view is defined in the default settings. You can view the different default settings by choosing the
command Preferences in the Windows menu. 

Figure 4.15 A dialog box for choosing a plane to view.

New Coordination View

This command opens a dialog that lets you specify which position in the unit cell you want to view coordination around, shown in
figure 4.16. Select a atom and click OK to view the specific coordination. 

The parameters for the initial coordination view is defined in the default settings. You can view the different default settings by
choosing the command Preferences in the Windows menu. 

Figure 4.16. A dialog box for choosing an atom to view coordination around. 
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The Info Window

The info window is a floating window that is only visible when a graph window is active. The info window gives you information
about the position of the selected atoms in the active graph window. If two atoms are selected the distance between them is also
shown, see Figure 4.17. If three atoms are selected both the distance and the angle between the different atoms are shown. You can
copy the contents of the info window to clipboard by choosing Copy Info Window in the Edit menu. Shift-click to selected one
atom simultaneously.

Figure 4.17 The Info Window shows the positions and distance between two selected atoms.

The Tool Window

The tool window in figure 4.18 is a floating window that is only visible when a graph window is active. By activating the document
window containing the crystal structure data the tool window will disappear. By using the different tools in this window you can
control the view direction and graph mode of your drawing.

Figure 4.18 The Tool Window

The tool window consist of three main regions. The upper part of the window consist of a region containing of nine icons. Only one
icon can be selected. Their properties are as described below: 

The  Selection  Tool.  With  this  tool  selected  you  can  select  different  atoms  in  the
drawing. By shift clicking you can select up to three atoms simultaneously.

The Magnification Tool. With this tool selected you can change the magnification by
dragging the mouse up or down inside your drawing.
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The Free Rotation Tool. With this tool selected you can rotate your crystal structure in
any direction. You are rotating around the centre of your crystal structure. 

The  Screen Normal  Rotation Tool.  This  tool  lets  you rotate  the  crystal  structure
around an axis that goes through the centre of your model in a direction normal to the
screen. 

The Screen Horizontal Rotation Tool. This tool lets you rotate the crystal structure
around an axis that goes through the centre of your model in horizontal direction. 

The  Screen Vertical  Rotation Tool.  This  tool  lets  you rotate  the  crystal  structure
around an axis that goes through the centre of your model in vertical direction.

The a-Axis Rotation Tool lets you rotate around an axis that is parallel to the a-axis of
your crystal structure. The axis goes through the centre of your model.

The b-Axis Rotation Tool lets you rotate around an axis that is parallel to the b-axis of
your crystal structure. The axis goes through the centre of your model.

The c-Axis Rotation Tool lets you rotate around an axis that is parallel to the c-axis of
your crystal structure. The axis goes through the centre of your model.
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In the centre of the tool window there is a button named Projection. By choosing this button a dialog box will be opened as shown in
figure 4.19.  

Figure 4.19. The projection dialog box.

Inside this dialog box you can set which crystallographic direction that should be parallel with the screen normal. You are only
allowed to enter integer values in the input fields. Click OK to update your graph to the new view direction.

In the lower part of the tool window three icons are located. With these three icons you can control the graph mode of your drawing.
The different graph modes are:

Atoms Only Mode. Only atoms are drawn.

Atoms and Bonds  Mode.  In  this  mode bonds  and atoms are  drawn and it  is
possible to create or modify coordination bonds between elements.

Atoms and Polyhedra Mode. Polyhedra and atoms are drawn and it is possible to
create new coordination polyhedra around an element.
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